
Product description 

The Mentype® Argus Y-MHQS PCR Amplification Kit is a multiplex application for the 
nine Y-chromosomal Short Tandem Repeat (STR) loci of the Minimal Haplotype (MH) 
standard. The primers of DYS19, DYS385ab, DYS389-I, DYS389-II, DYS390, 
DYS391, DYS392, and DYS393 are fluorescence-labelled with 6-FAM or HEX.  
 
The test kit was developed specifically for fast and reliable generation of male DNA 
profiles from mixtures of male and female DNA up to a ratio of 1:6000 so that 
separation of sperm from female cells or differential lysis is not required. The detection 
limit of the Mentype® Argus Y-MHQS PCR Amplification Kit is up to 100 pg genomic 
male DNA. However, it is recommended to use 0.1-1.0 ng male DNA. 
 
As special feature, Mentype® Argus Y-MHQS contains an internal PCR control 
(Quality Sensor “QS”) which provides helpful information on the efficiency of the PCR 
and on the presence of PCR inhibitors. 
 
The Mentype® Argus Y-MHQS was developed according to the recommendations of 
the International Forensic Y-User Group (http://www.yhrd.org/index.html). This 
consortium has evaluated a core set of a highly informative Y-STR, the so called 
Minimal Haplotype which was recommended for court. Generation of DNA profiles 
using Mentype® Argus Y-MHQS corresponds to the guidelines of the International 
Society for Forensic Genetics (Gill et al., 2001 a and b; Gusmão et al., 2005a). All 
important population-genetic data could be calculated with the GenoProof® Software. 
 
The test kit was validated and evaluated using the GeneAmp® 9700 thermal cycler, 
ABI PRISM® 310 Genetic Analyzer, and ABI PRISM® 3100/3130 Genetic Analyzer. 
 
 
Table 1. Locus-specific information of Mentype® Argus Y-MHQS 
STR Locus GenBank® 

accession 
Repeat motif  
of the reference allele 

Reference 
allele 

Allele 
range 

DYS19 AC017019 [TAGA]3 TAGG [TAGA]12 15   9-19 
DYS385 AC022486 [GAAA]11 11   6-28 
DYS389-I AC004617 [TCTG]3[TCTA]9 12   9-17 
DYS389-II AC004617 [TCTG]5 [TCTA]12 [TCTG]3 [TCTA]9  29 24-35 
DYS390 AC011289 [TCTG]8 [TCTA]11 [TCTG]1 [TCTA]4 24 12, 17-29 
DYS391 AC011302 [TCTA]11 11   5-16 
DYS392 AC011745 [TAT]13 13   4-20 
DYS393 AC006152 [AGAT]12 12   7-18 
 
Table 1 shows the STR loci with their repeat motifs and alleles. The most frequent 
alleles for European populations are included in the allelic ladder. Allele ranges include 
all known alleles of YHRD (http://www.yhrd.org as at 12/2008) and of the current 
literature. 
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Fig. 1 The ideogram of the Y-chromosome describes the physical localisation of the STR loci which can be 
analysed with Mentype® Argus Y-MHQS. The positions of the STR loci are shown in Mb (http://www.ncbi.nlm. 
nih.gov/genome /guide/human as at 08/2008).  
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Table 2. Chromosomal Mapping of Mentype® Argus Y-MHQS 

Locus Chromosomal mapping   
DYS19 Yp11.2   
DYS385 Yq11.222   
DYS389-I Yq11.21   
DYS389-II Yq11.21   
DYS390 Yq11.221   
DYS391 Yq11.21   
DYS392 Yq11.222   
DYS393 Yp11.31   
 
 
Content 

Mentype® Argus Y-MHQS PCR Amplification Kit (100 Reactions) 
Nuclease-free water 3.0 mL 
Reaction mix B 500 μL 
Primer mix 250 μL 
DNA polymerase 40 μL 
Control DNA XY1 (2 ng/μL) 10 μL 
Control DNA XX (50 ng/μL) 10 μL 
DNA Size Standard 550 (ROX) 50 μL 
Allelic ladder 10 μL 
 
 
Ordering information 
Mentype® Argus Y-MHQS 25 reactions Cat. No. 42-09112-0025 
Mentype® Argus Y-MHQS 100 reactions Cat. No. 42-09112-0100 
Mentype® Argus Y-MHQS 400 reactions Cat. No. 42-09112-0400 

 
 
Storage 
Store all components at -20°C and avoid repeated thawing and freezing. Primer mix 
and allelic ladder must be stored protected from light. The DNA samples and post-PCR 
reagents (allelic ladder and DNA size standard) should be stored separately from the 
PCR reagents. The expiry date is indicated on the kit cover. 
 
 
Quality assurance 

All kit components undergo an intensive quality assurance process at Biotype 
Diagnostic GmbH. The quality of the test kits is permanently monitored in order to 
ensure unrestricted usability. Please contact us if you have any questions regarding 
quality assurance. 
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Additionally required reagents  

Additional reagents are needed in order to use the Biotype® PCR Amplification Kit: 
Reagent Supplier Order number 
Hi-Di™ Formamide, 25 mL Applied Biosystems 4311320 
Matrix Standards DS-30 
for ABI PRISM® 310 Genetic Analyzer Applied Biosystems 401546 und 402996 (NED) 

Matrix Standards DS-30 
for ABI PRISM® multi-capillary instruments Applied Biosystems 4345827 

 
 
Trademarks and patents 

Mentype® is a registered trademark of Biotype Diagnostic GmbH. 
GenoProof® is a registered trademark of Qualitype AG. 
ABI PRISM®, GeneScan®, Genotyper®, GeneMapper™ and Applied Biosystems are 
registered trademarks of Applied Biosystems Inc. or its subsidiaries in the U.S. and 
certain other countries. 
6-FAM, HEX, NED, ROX, POP-4 and Hi-Di are trademarks of Applied Biosystems Inc. 
GeneAmp® is a registered trademark of Roche Molecular Systems. 
The PCR is covered by patents. Patentees are Hoffmann-La Roche Inc. and 
F. Hoffmann-La Roche (Roche). 
GenBank® is a trademark of National Institute of Health. 
 
 
Warnings and safety instructions 

The PCR Amplification Kit contains the following potentially hazardous chemicals:  
Kit component Chemical Hazards 
Primer mix, reaction mix 
and allelic ladder 

Sodium azide NaN3 toxic if swallowed, develops toxic gases 
when it gets in contact with acids  

Observe the Material Safety Data Sheets (MSDS) for all Biotype® products, which are 
available on request. Please contact the respective manufacturers for copies of the 
MSDS for any additionally needed reagents. 
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1. PCR amplification 

1.1 Master mix preparation 

The table below shows the volumes of all PCR reagents per 25 μL reaction volume, 
including a sample volume of 1.0 μL (template DNA). The number of reactions to be 
set up shall be determined taking into account positive and negative control reactions. 
Add one or two reactions to this number to compensate the pipetting error. 
 
Component Volume 
Nuklease-free water 16.1 μL 
Reaction mix B* 5.0 μL 
Primer mix 2.5 μL 
Multi Taq2 DNA Polymerase (hot start, 2.5 U/μL) 0.4 μL 
Volume of master mix 24.0 μL 

* contains Mg2+, dNTPs, BSA 
 
All components should be mixed (vortex) and centrifuged for about 10 s before 
preparing the master mix. The DNA volume applied to the assay depends on its 
concentration. A volume of up to 5 μL may be necessary for DNA trace templates. DNA 
volumes of more than 5 μL are not recommended, because potential PCR inhibitors 
may interfere with the process. Fill up the final reaction volume to 25 μL with 
nuclease-free water. 
 
Generally, DNA templates shall be stored in nuclease-free water or in diluted TE buffer 
(10 mM Tris HCl, pH 8.0 and 1 mM EDTA), e.g. 0.1x TE buffer. 
 
The primer mixes are adjusted for balanced peak heights at 30 PCR cycles and 
0.5 ng Control DNA XY1 in a reaction volume of 25 μL. If more DNA template is 
introduced, higher peaks can be expected for small PCR fragments and relatively low 
peaks for large fragments. Reduce the amount of DNA template to correct this 
imbalance. 
 
 
Positive control 

For the positive amplification control, dilute the Control DNA XY1 to 0.5 ng in the 
appropriate volume. Instead of the template DNA, pipette the diluted Control DNA into a 
reaction tube containing the PCR master mix. 
 
Negative control 
For the negative amplification control, pipette nuclease-free water instead of template 
DNA into a reaction tube which contains the PCR master mix. 
 
 

Protocols for PCR amplification, electrophoresis, and analysis
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1.2 PCR amplification parameter 

Perform a “hot start” PCR in order to activate the Multi Taq2 DNA Polymerase and to 
prevent the formation of non-specific amplification products. 
 
The number of cycles depends on the amount of DNA. 30 cycles are recommended for 
all samples. For critical stains (< 100 pg DNA), it is recommended to increase the 
number of PCR cycles from 30 to 34. 
 

Standard method 
Recommended for all DNA samples  
Temperature Time 
94°C 4 min (hot start for activation of the Multi Taq2 DNA Polymerase) 
94°C 30 s 
58°C 120 s 
72°C 75 s 

30 cycles 

68°C 60 min  
10°C ∞ hold 
 
 

Optional 

Recommended for stains with small amounts of genomic DNA 
Temperature Time 
94°C 4 min (hot start for activation of the Multi Taq2 DNA Polymerase) 
94°C 30 s 
58°C 120 s 
72°C 75 s 

34 cycles 

68°C 60 min  
10°C ∞ hold 

 
 
Too Small amounts of DNA may result in allelic dropouts and imbalances of the peaks. 
Furthermore, unspecific amplification products could appear. With increasing numbers 
of cycles, there is the risk of cross contamination caused by minimal amounts of 
impurities. 



 

Mentype® Argus Y-MHQS July 2010 

8 

2. Electrophoresis using the ABI PRISM® 310 Genetic Analyzer 

For general instructions on instrument setup, matrix generation and application of the 
GeneScan® or GeneMapper™ ID software, refer to the ABI PRISM ® 310 Genetic 
Analyzer User’s Manual. Electrophoresis using the GeneScan® software is described 
below.  
 
The virtual filter set D shall be used for combined application of the four fluorescent 
labels 6-FAM, HEX, NED, and ROX (also called DS-30). Generally, Filter Sets A and F 
are suitable, too.  
 
Material  
Capillary 47 cm / 50 μm (green) 
Polymer POP-4 for 310 Genetic Analyzer  
Buffer 10x Genetic Analyzer Buffer with EDTA 
 
 

2.1 Matrix generation 
Prior to conducting DNA fragment size analysis with the filter set D, a matrix with the 
four fluorescent labels 6-FAM, HEX, NED, and ROX must be generated. The suitable 
matrix standard DS-30 is available from Applied Biosystems. 
 
Colour Matrix standard Order number 
Blue (B) 6-FAM Applied Biosystems, 401546 
Green (G) HEX Applied Biosystems, 401546 
Yellow (Y) NED Applied Biosystems, 402996 
Red (R) ROX Applied Biosystems, 401546 
 
Four electrophoresis runs shall be conducted, one for each fluorescent label, 6-FAM, 
HEX, NED, and ROX, under the same conditions as for the samples and allelic ladders 
of the Biotype® test kit to generate suitable matrix files. 
 
Matrix sample Component Volume 

Hi-Di™ Formamide 12.0 μL 
Matrix sample 1 

Matrix standard 6-FAM 1.0 μL 
   

Hi-Di™ Formamide 12.0 μL 
Matrix sample 2 Matrix standard HEX 1.0 μL 
   

Hi-Di™ Formamide 12.0 μL 
Matrix sample 3 

Matrix standard NED 1.0 μL 
   

Hi-Di™ Formamide 12.0 μL 
Matrix sample 4 

Matrix standard ROX 1.0 μL 
- Denaturation for 3 min at 95°C 
- Cool down to 4°C 
- For analysis: load the samples on the tray 
 
- Create a Sample Sheet and enter sample designation 
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Injection list for matrix generation 
Parameter Set up 
Module File GS STR POP-4 (1 mL) D 
Matrix File NONE 
Size Standard* NONE 
Injection [s] 5 
Injection [kV] 15.0 
Run [kV] 15.0 
Run [°C] 60 
Run Time [min] 24 

* prepare matrix standards always without DNA Size Standard (ROX)  
 
Analysis of the matrix samples 
- Run the GeneScan® software 
- File → New → Project (open folder of current run) → Add Sample Files 
- Select a matrix sample in the Sample File column  
- Sample → Raw Data 
- Check the matrix samples regarding a flat baseline. As shown in the figure below, 

there should be at least five peaks with peak heights about 400-4000 (Y-axis) for 
each matrix sample (optimal range: 1000-3000) 

 

 
Fig. 2 Electropherogram with raw data of the matrix standard 6-FAM 
 
- Select analysis range with flat baseline and re-inject the matrix sample if necessary 
- Note down start and end value (data points) of the analysis range, e.g.  
   start value 3400, end value 6400 
- Calculate the difference, e.g. 6400-3400 = 3000 data points 

 ▼ 3400 Data Points (X) 
 

 6400▼ 
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Generation of a new matrix 

- File → New → Matrix 

 
Fig. 3 Matrix sample selection 

 
- Import matrix samples for all dyes (B, G, Y, R) 
- Enter a Start At value, e.g. 3400 
- Enter the calculated difference under Points, e.g. 3000 
- Click on OK to calculate the new matrix 
 

 
Fig. 4 New matrix DS-30 
 
- Save the matrix in the matrix folder: File → Save as, e.g. Matrix DS-30 
 
 
Matrix check 

Check the new matrix with current samples. 
- File → New → Project (open folder of the respective run) → Add Sample Files 
- Select sample(s) in the Sample File column  
- Sample → Install New Matrix (open matrix folder and select new matrix) 
- Re-analyse your samples 
 
There should be no pull-up peaks between the dye panels (B, G, Y, R) with the new 
matrix. 
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2.2 Sample preparation 
Component Volume 
Hi-Di™ Formamide 12.0 μL 
DNA Size Standard 550 (ROX) 0.5 μL 
prepare 12 μL of the mix (formamide + DNA size standard) for all samples  
add 1 μL PCR product (diluted if necessary) or allelic ladder  
- Denaturation for 3 min at 95°C  
- Cool down to 4°C  
- For analysis: load the samples on the tray  
 
 
Signal intensities 

Options to increase the signal intensity: 
- Reduce the volume of the DNA Size Standard 550 (ROX) to peak heights of  

about 500 relative fluorescent units (RFU)  
- Purify the PCR products before starting the analysis  
 
 

2.3 Setting up the GeneScan® software 

- Create a Sample sheet and enter sample designation 
 
Injection list 
Parameter Set up 
Module File GS STR POP-4 (1 mL) D 
Matrix File e.g. Matrix Biotype 
Size Standard e.g. SST-ROX_50-400bp 
Injection [s]* 5 
Injection [kV] 15.0 
Run [kV] 15.0 
Run [°C] 60 
Run Time [min]** 26 

* Deviating from standard settings, the injection time may range between 1 and 10 s depending on the type of 
sample. If blood samples with very high signal intensities are recorded, a shorter injection time may be selected. 
For samples with low DNA content an injection time up to 10 s may be necessary.  

 
** Depending on the analysis conditions the run time for Mentype® Argus Y-MHQS was modified in order to 
analyse fragments with lengths of up to 400 bp. 
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2.4 Analysis parameter 

The recommended analysis parameters are: 
 
Analysis Range Start: 2000 

Stop: 10000 
Data Processing Baseline: Checked 

Multicomponent: Checked 
Smooth Options: Light 

Peak Detection Peak Amplitude Thresholds 
B:*    Y:* 
G:*    R:* 
Min. Peak Half Width: 2 pts 
Polynorminal Degree: 3 
Peak Window Size: 11 pts** 

Size Call Range Min: 50 
Max: 550 

Size Calling Method Local Southern Method 
Split Peak Correction None 

 

* The peak amplitude threshold (cutoff value) corresponds to the minimum peak height that will be detected by 
the GeneScan® or GeneMapper™ ID software. Thresholds are usually 50-200 RFU and should be determined 
individually by the laboratory. Recommendation: The minimal peak height should be three times as high as the 
background noise of the baseline. 

 
** Point alleles (i.e. alleles with at least 1 bp difference to the next integer allele) may occasionally not be 
distinguished. For improved peak detection, minimise the Peak Window Size further. 
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3. Electrophoresis using the ABI PRISM® 3130/3130xl Genetic Analyzer 

For detailed instructions on instrument setup, spectral calibration, or application of the 
ABI PRISM® Data Collection software version 3.0 and the GeneMapper™ ID software, 
refer to the ABI PRISM ® 3130/3130xl Genetic Analyzers Getting Started Guide.  
 
The system with 4 capillaries is named ABI 3130 (former ABI 3100-Avant), and the 
system with 16 capillaries is named ABI 3130xl (former ABI 3100).  
 
The virtual filter set D shall be used for combined application of the four fluorescent 
labels 6-FAM, HEX, NED, and ROX (also called DS-30). 
 
Material  
Capillary 36 cm Capillary Array for 3130/3130xl 
Polymer POP-4 Polymer for 3130 
Buffer 10x Genetic Analyzer Buffer with EDTA 
 
 

3.1 Spectral calibration / matrix generation 

Prior to conducting DNA fragment size analysis, it is necessary to perform a spectral 
calibration with the four fluorescent labels 6-FAM, HEX, NED, and ROX for each 
analyzer. The calibration procedure creates a matrix which is used to correct the 
overlapping of fluorescence emission spectra of the dyes.  
 
Spectral calibration comprises the following steps: 
- Preparation the spectral calibration standards 
- Loading the standards to the 96-well reaction plate (one sample per capillary) 
- Creating the instrument protocol for spectral calibration (Protocol Manager) 
- Defining the plate composition in the plate editor (Plate Manager) 
- Performing a spectral calibration run and checking the matrix 
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Setting up the spectral calibration standards 

Example for 4 capillaries/ABI 3130 
Component Volume 
Hi-Di™ Formamide 47.5 μL 
Matrix standard DS-30 2.5 μL 
- Load 12 μL of the mix to a 96-well reaction plate, e.g. position A1-D1 
- Denaturation for 3 min at 95°C 
- Cool down to 4°C 
 
 
Example for 16 capillaries/ABI 3130xl 
Component Volume 
Hi-Di™ Formamide 190.0 μL 
Matrix standard DS-30 10.0 μL 
- Load 12 μL of the mix to a 96-well reaction plate, e.g. position A1-H1 and A2-H2 
- Denaturation for 3 min at 95°C 
- Cool down to 4°C 
 
 
Performing a spectral calibration run 

- Insert the 96-well plate on the autosampler tray 
- In the Protocol Manager of the Data Collection Software click New the window 

Instrument Protocol to open the Protocol Editor dialog box 
 
 
Instrument Protocol for spectral calibration 
Protocol Editor Set up 
Name User (e.g. Spectral36_POP4_DS30) 
Type SPECTRAL 
Dye Set D 
Polymer* User (e.g. POP4) 
Array Length* User (e.g. 36cm) 
Chemistry Matrix Standard 
Run Module* Default (e.g. Spect36_POP4_1) 

* Depends on the type of polymer and length of capillary used 
 
- Select OK to complete the Protocol Editor dialog box 
- In the Plate Manager of the Data Collection software click New to open the New 

Plate Dialog box 
 
Plate Editor for spectral calibration (I) 
New Plate Dialog Set up 
Name e.g. Spectral_DS-30_date 
Application Spectral Calibration 
Plate Type 96-Well 
Owner Name / Operator Name … 
 
- Select OK. A new table in the Plate Editor opens automatically 
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Plate Editor for spectral calibration (II) 
Parameter Set up 
Sample Name Type name for the matrix samples 
Priority  e.g. 100  
Instrument Protocol 1 Spectral36_POP4_DS30 (setting described before) 
 
- Click into the column header to select the entire column, select Edit → Fill Down to 

apply the information to all selected samples, and click on OK 
- In the Run Scheduler click on Find All, select Link to link the reaction plate on the 

autosampler up with the newly created plate record (position A or B) and start the run 
 

 
Fig. 5 Electropherogram of spectral calibration with matrix standard DS-30 on an ABI 3130 
 
 
Matrix check 

- The quality value (Q value) of each capillary must be greater than 0.95 and the  
   condition number range (C value) must be between 1 and 20. 
- Check the matrix samples for a flat baseline. As shown in the figure above, there 

should be four peaks with peak heights of about 1000-5000 (Y-axis) in each matrix 
sample (optimal range: 2000-4000) 

- Check the new matrix with your current samples. There should be no pull-up peaks 
between the dye panels (B, G, Y, R, O) with the new matrix 

- If calibration was not successful, use the optimised values and repeat the calibration 
run 

- If all capillaries have passed the test, the last calibration file for the Dye Set D is 
activated automatically in the Spectral Viewer. Rename the calibration file (e.g. 
DS-30_Date of calibration) using the respective button 

   R, Y,    G,     B 
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3.2 Sample preparation 
Component Volume 
Hi-Di™ Formamide 12.0 μL 
DNA Size Standard 550 (ROX)   0.5 μL 
prepare 12 μL of the mix (formamide + DNA size standard) for all samples 
add 1 μL PCR product (diluted if necessary) or allelic ladder 
- Denaturation for 3 min at 95°C  
- Cool down to 4°C  
- For analysis: load the samples on the tray  
 
Since injections take place simultaneously on all capillaries, 4 or 16 samples must be 
pipetted on the plate of multi-capillary analysers. If fewer samples are analysed, the 
empty positions must be filled with 12 μL Hi-Di™ Formamide. 
 
To ensure a reliable allelic assignment on multi-capillary analysers, a number of allelic 
ladders should be run, independently from sample number. 
 
Room temperature may influence the performance of PCR products on multi-capillary 
instruments, so that shoulder peaks or split peaks occur especially at low 
temperatures. Pay attention to keeping ambient conditions as recommended by the 
instrument manufacturer.. 
 
 
Signal intensities 

Options to increase the signal intensity: 
- Reduce the volume of the DNA Size Standard 550 (ROX) to peak heights of about 

500 relative fluorescent units (RFU)  
- Purify the PCR products before starting the analysis  
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3.3 Setting up the GeneMapper™ ID software 

Edit the Run Module as follows for the first run: 
- In the Module Manager of the Data Collection software click on New to open the 

Run Module Editor dialog box 
 
Run Module 3kV_10s_400bp 
Parameter Set up 
Oven Temperature [°C] Default 
Poly Fill Volume Default 
Current Stability [μA] Default 
PreRun Voltage [kV] Default 
PreRun Time [s] Default 
Injection Voltage [kV] 3.0 
Injection Time [s]* 10 
Voltage Number of Steps Default 
Voltage Step Interval Default 
Data Delay Time [s] Default 
Run Voltage [kV] Default 
Run Time [s]** 1200 

* Deviating from the standard settings, the injection time may range between 1 and 20 s depending on the type 
of sample. If samples with very high signal intensities are recorded, a shorter injection time may be selected. 
For samples with low DNA content an injection time of up to 20 s may be necessary.  
 
** Depending on the analysis conditions the run time for Mentype ® Argus Y-MHQS was modified in order to be 
able to analyse fragments with lengths of up to 400 bp. 

 

- Click on Save As, enter the name of the new module (e.g. 3kV_10s_400bp) and confirm 
with OK 

- Click on Close to exit the Run Module Editor 
 
 
Starting the run 

- Place the prepared 96-well plate on the autosampler tray 
- In the Protocol Manager of the Data Collection software, click on New in the 

Instrument Protocol window to open the Protocol Editor dialog box 
 

Instrument Protocol 
Protocol Editor Set up 
Name e.g. Run36_POP4_DS-30_20min 
Type REGULAR 
Run Module* 3kV_10s_400bp 
Dye Set D 

* parameter see above 
 
- Click on OK to exit the Protocol Editor 
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Prior to each run, it is necessary to create a plate definition as follows: 
- In the Plate Manager of the Data Collection software click on New to open the New 

Plate Dialog box 
 
GeneMapper™ Plate Editor (I) 
New Plate Dialog Set up 
Name e.g. Plate_DS-30_Date 
Application select GeneMapper Application 
Plate Type 96-Well 
Owner Name / Operator Name … 
 
- Click OK. A new table in the Pate Editor opens automatically 
 
GeneMapper™ Plate Editor (II) 
Parameter Set up 
Sample Name Type name for the samples 
Priority  e.g. 100 (Default)  
Sample Type Sample or Allelic Ladder 
Size Standard e.g. SST-ROX_50-400bp 
Panel e.g. Biotype_Panels_v3a (choose test kit) 
Analysis Method e.g. Analysis_HID_3130 
Snp Set - 
User-defined 1-3 - 
Results Group 1 (select results group) 
Instrument Protocol 1 Run36_POP4_DS-30 (setting described earlier) 
 
 
- Click into the column header to select the entire column, select Edit → Fill Down to 

apply the information to all selected samples and click on OK 
- In the Run Scheduler, click on Find All, select Link to link the reaction plate on the 

autosampler up with the newly created plate record (position A or B) and start the run  
- During the run, view Error Status in the Event Log or examine the quality of the raw 

data for each capillary in the Capillaries Viewer or the Cap/Array Viewer 
- View data as overview in Run History or Cap/Array Viewer of the Data Collection 

software. Run data are saved in the Run Folder of the previously chosen Result 
Group 
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3.4  Analysis parameter / analysis method 

The recommended settings in the worksheet Peak Detector are: 
 
Peak Detection Algorithm Advanced 
Ranges Analysis: Partial Range 

Start Pt: 2000; Stop Pt: 10000 
Sizing: All Sizes 

Smoothing and Baselining Smoothing: Light  
Baseline Window: 51 pts 

Size Calling Method Local Southern Method 
Peak Detection Peak Amplitude Thresholds 

B:*    Y:* 
G:*    R:* 
Min. Peak Half Width: 2 pts 
Polynominal Degree: 3 
Peak Window Size: 11 pts** 
Slope Thresholds: 0.0 

* The peak amplitude threshold (cutoff value) corresponds to the minimum peak height that will be detected by 
the GeneMapper™ ID software. The thresholds are usually 50-200 RFU and should be determined individually 
by the laboratory. Recommendation: The minimal peak height should be three times as high as the background 
noise of the baseline. 
 
** Point alleles (i.e. alleles with at least 1 bp difference to the next integer allele) may occasionally not be 
distinguished. For improved peak detection, minimise the Peak Window Size further. 
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4. Analysis 

For general instructions on automatic sample analysing, refer to the GeneScan® or 
GeneMapper™ ID Software User’s Manual.   
 
Finding the exact lengths of the amplified products depends on the device type, the 
conditions of electrophoresis, as well as the DNA size standard used. Due to the 
complexity of some loci, determining the size should be based on evenly distributed 
references. The DNA Size Standard 550 (ROX) shall thus be used with the following 
lengths of fragments: 50, 60, 70, 80, 90, 100, 120, 140, 160, 180, 190, 200, 220, 
240, 260, 280, 300, 320, 340, 360, 380, 400, 425, 450, 475, 500, 525, and 550 
bp.  
 

 
Fig. 6 Electropherogram of the DNA Size Standard 550 (ROX), fragments with lengths in bp 
 
Note: The basic template files for the DNA Size Standard 550 (ROX) has to be adjusted 
to 400 bp within the GeneMapper™ ID software. The new template could be saved as 
e.g. SST-ROX_50-400bp and used for further analyses.  
 
 
As mentioned before, Mentype® Argus Y-MHQS contains an internal PCR control 
(Quality Sensor), which provides helpful information on the efficiency of the PCR and on 
presence of PCR inhibitors. A 6-FAM labelled 81 bp-fragment is amplified 
independently of the DNA. The PCR control assay without DNA shows only the sensor 
fragment (Fig. 7) and indicates successful polymerase chain reaction.  
 

 
Fig. 7 Electropherogram of the 6-FAM labelled PCR control fragment (Quality Sensor). Fragment length in bp, 
signal intensities in peak height 
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Special features 

In general, the electropherogram displays a single peak for each Y-STR locus. 
However, locus DYS385 produces two peaks of different or same length. These two 
fragments originate from duplicated and inversed copies of one Y-chromosomal locus. 
The primers provided in the test kit simultaneously co-amplify the two homologous loci. 
For separate amplification, see Kittler et al., 2003. 
 
Concerning locus DYS385 it must be stressed that alleles 14.3, 15.3, 16.3, 17.3, and 
19.3 represent the alleles 15, 16, 17, 18, and 20, respectively, with one thymidine 
deletion between the primer binding site and the repeat region (Füredi et al., 1999). 
This deletion may serve as an additional distinctive feature for differentiation in forensic 
casework. 
 
If more than one peak is obtained in the electropherogram for one or several markers, 
this does not necessarily hint at mixed samples. Duplications or triplications of STR 
markers also result in such an effect and have already been observed for DYS385 and 
DYS19 (Butler et al., 2005). Rarely, single systems can fail too because of Y-
chromosomal deletions as known in azoospermic patients, as already described for 
DYS385 and DYS392 (Stein et al., 2005). 
 
Mutation rates for intermediate or infrequent alleles of the Y-STR system of the 
Mentype® Argus Y-MHQS test kit varies between 0,613×10-3 and 5,296×10-3 
(Gusmão et al., 2005b). 
 
Allele frequencies of the European Minimal Haplotype Standard are collected and 
published by the Biotype Diagnostic GmbH (Rodig et al., 2007). They can be received 
as download from our homepage (www.biotype.de). Furthermore, there is free access 
to the “Y-Chromosome Haplotype Reference Database” from the International Forensic 
Y-User Group (http://www.yhrd.org/index.html) in order to calculate frequencies 
oneself. 
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4.1 Biotype® template files 

Allele allocation should be carried out with a suitable analysis software, e.g. 
GeneMapper™ ID or Genotyper® software in combination with the Mentype®  
Argus Y-MHQS template files from Biotype. Template files are available from our 
homepage or as CD-ROM on request.  
 

Recommended Biotype® templates for GeneMapper™ ID/ID-X software are: 
Panels Biotype_Panels_v3a/v3X (choose kit) or higher versions 
BinSets Biotype_Bins_v3a/v3X or higher versions 
Size Standard SST-ROX_50-500bp (adjust up to 400bp, adjustment described earlier) 
Analysis Method Analysis_HID_310  
 Analysis_HID_3130  
 Analysis_HID_310_50rfu  
 Analysis_HID_3130_50rfu  
Plot Settings Plots_3dyes  
Table Settings Table for 2 alleles   
 Table for 10 alleles  
 
Panels and BinSets always have to be used whereas the other template files are 
optional.  
 

Additional Biotype® templates for GeneMapper™ ID-X Software: 
Stutter* Biotype_Stutter_v3X or higher version 

* When loading the above mentioned panels, the stutter settings will not be accepted. Thus, the stutter data has 
to be imported separately.  
 

Recommended Biotype® template files for Genotyper® software are: 
Argus_YMH-QS_v2c or higher versions 
 

General procedure for the analysis 

1. Check the DNA size standard 
2. Check the allelic ladder 
3. Check the positive control 
4. Check the negative control 
5. Analyse and interpret the sample data 
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4.2 Controls 

The Control DNA XY1 of the test kit and other commercially available DNA from 
standard cell lines represent the following alleles: 
 
Table 3. Allele determinations of Mentype® Argus Y-MHQS 

STR Locus Control DNA 
XY1 

Control DNA 
XX 

ATCC 
K-562 

CCR 
9947 

CCR 
9948 

CCR 
3657 

DYS19 13 - - - 14 13 
DYS385ab 16 / 17 - - - 11 / 14 16 / 19 
DYS389-I 13 - - - 13 12 
DYS389-II 30 - - - 31 29 
DYS390 24 - - - 24 24 
DYS391 11 - - - 10 10 
DYS392 11 - - - 13 11 
DYS393 13 - - - 13 13 
 
No PCR fragments are amplified with the Control DNA XX, but may be used to generate 
mixtures with the Control DNA XY1. The reference DNA K-562 is availble from ATCC 
(http://www.atcc.org/Products/ PurifiedDNA.cfm#celllines). For further confirmation, 
the table above displays the Y-chromosomal alleles of two reference DNAs purchased 
from Coriell Cell Repositories (CCR; http://locus.umdnj.edu/nigms) that is up to the 
standard of Szibor et al., 2003. 
 
 

4.3 Lengths of fragments and alleles 

Table 4 to table 5 show the fragment lengths of individual alleles that refer to the 
DNA Size Standard 550 (ROX). All analyses have been performed on an 
ABI PRISM® 310/3130 Genetic Analyzer with POP-4 polymer. Different analysis 
instruments, DNA size standards or polymers may result in different fragment lengths. 
In addition, a visual alignment with the allelic ladder is recommended. 
 
 
Scaling 

Horizontal: 85-405 bp (with Quality Sensor 75-405 bp) 
Vertical:  Depending on signal intensity 
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Figure 8 

A 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
B 

Fig. 8 Electropherogram of the Mentype® Argus Y-MHQS using 500 pg Control DNA XY1 (A) or 100 pg male Control DNA XY1 mixed 
with 50 ng female Control DNA XX (B). The Quality Sensor (QS) is shown at 81 bp. Analysis was performed on an ABI PRISM® 310 
Genetic Analyzer with the DNA Size Standard 550 (ROX). Allele assignment was performed using the Genotyper® software and the 
Mentype® Argus Y-MHQS template file. 

     QS              DYS393              DYS390   DYS385 

DYS391             DYS19         DYS389-I       DYS392             DYS389-II 

   DNA Size Standard 550 (ROX) 

     QS              DYS393              DYS390   DYS385 

DYS391              DYS19         DYS389-I       DYS392             DYS389-II 

   DNA Size Standard 550 (ROX) 
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Figure 9 
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Table 4. Fragment lengths of the allelic ladder Mentype® Argus Y-MHQS analysed  
on an ABI PRISM® 310 Genetic Analyzer (blue panel) 
 
Marker/allele Size [bp]*  Further 

Allele** Marker/allele Size [bp]*  Further 
Allele** Marker/allele Size [bp]*  Further 

Allele** 

PCR control 6-FAM  DYS390 6-FAM  DYS385 6-FAM  

Quality Sensor 81  20 201 17, 18, 19 9 274 7, 8 

   21 205  10 278 10.1 

DYS393 6-FAM  22 209  11 282  

11 113 8, 9, 10 23 213  12 286 12.2 

12 117 12.2 24 217 24.3 13 290  

13 121  25 221 25.2 13.2 292  

14 126  26 225  14 294 14.2, 14.3 

15 130  27 230 28, 29 15 298  

16 134 17, 18    15.2 300 15.3 

      16 302 16.2, 16.3 

      17 305 17.1, 17.2, 17.3 

      18 309 18.1 

      19 313  

      20 317  

      21 321 22, 23, 24, 25, 28 
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Table 5. Fragment lengths of the allelic ladder Mentype® Argus Y-MHQS analysed on an 
ABI PRISM® 310 Genetic Analyzer (green panel) 

 
Marker/allele Size [bp]*  Further 

Allele** Marker/allele Size [bp]*  Further 
Allele** Marker/allele Size [bp]*  Further 

Allele** 

DYS391 HEX  DYS389-I HEX  DYS389-II HEX  

8 106 6, 7 11 245 8, 9, 10, 10.2 27 363 23, 24, 25, 26 

9 110 9.3 12 249  28 367  

10 114  13 253  29 371  

11 119  14 257  30 375  

12 123  15 261 16, 17 31 379  

13 127 14    32 383  

   DYS392 HEX  33 387 34, 35 

DYS19 HEX  7 292 6, 8, 9    

11 178 10 10 301     

12 182  11 304 11.1    

13 186  12 307     

14 191 14.3 13 310     

15 195  14 313     

16 199  15 316 16, 17, 18    

17 203        

18 207 19       

         

* rounded to integer 

** The “off-ladder” alleles of Biotype’s DNA pool are allocated with the actual Biotype® template files for GeneMapper™ ID or 
Genotyper® software. For further alleles see amongst others http://www.cstl.nist.gov/biotech/strbase/str_fact.htm or 
http://www.yhrd.org 
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5. Interpretation of results 

As mentioned above, post PCR analysis and automatic allele assignment with 
suitable analysis software ensure a precise and reliable discrimination of 
alleles. 
 
Pull-up peaks 

Pull-up peaks may occur if peak heights are outside the linear detection range 
(>3000 RFU), or if an incorrect matrix was applied. They appear at positions of 
specific peaks in other colour channels, typically with lower signal intensities. 
Peak heights should not exceed 3000 RFU in order to prevent pull-up peaks.  
 
Stutter peaks 

The occurrence of stutter peaks depends on the sequence of the repeat 
structure and the number of alleles. n-4 peaks are caused by a loss of a repeat 
unit during amplification of tetranucleotide STR motives, caused by slippage 
effects of the Taq DNA Polymerase, whereas n+3 and n-3 peaks appear 
particularly during amplification of the trinucleotide STR motif DYS392 (Mulero 
et al, 2006). Those peaks should be interpreted in accordance with the 
template files of the Genotyper® and GeneMapper™ ID software. 
 
Template-independent addition of nucleotides 

Because of its terminal transferase activity, the Taq DNA Polymerase tends to 
add an adenosine radical at the 3’-end of the amplified DNA fragments. The 
artefact peak is one base shorter than expected (-1 peaks). All Biotype® 
primers are designed to minimise these artefacts. Artefact formation is further 
reduced by the final extension step of the PCR protocol at 68°C for 60 
minutes. Peak height of the artefact correlates with the amount of DNA. 
Laboratories should define their own limits for analysis of the peaks. 
 
Quality Sensor to check the PCR results 

Mentype® Argus Y-MHQS contains an internal PCR check (Quality Sensor), 
which provides helpful information on the efficiency of the PCR and on 
presence of PCR inhibitors (see Fig. 7). Complete sensor failure indicates total 
inhibition of the PCR or errors in the assay. If the sensor signal is amplified in 
presence of DNA either in the negative control or in the positive control, the 
PCR is not inhibited. Samples with sufficient DNA and without inhibiting 
substances result in the DNA profile according to the kit and the sensor 
fragment. Reduced sensor peak heights in forensic samples indicate partial 
PCR inhibition. If only the Quality Sensor is amplified, the sample contains very 
little, only female or degraded DNA. 
 
Artefacts  

Room temperature may influence the performance of PCR products on multi-
capillary instruments, so that shoulder peaks or split peaks occur. If shoulder 
or split peaks appear, we recommend injecting the sample again. 
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